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Identification of the µ Rhythm Neural Components in an EEG Time-Frequency Analysis of 

Speech Production in Fluent Speakers and Speakers who Stutter 

Thesis Abstract—Idaho State University (2018) 

Stuttering has been associated with sensorimotor control deficits and the mu rhythm has been 

proposed as a reliable marker of this phenomenon in electroencephalography (EEG) research. 

The purpose of this methodological-based project is to describe the procedures associated with 

identifying mu rhythm neural components from people who stutter (PWS) and typically fluent 

speakers (TFS) during three-syllable word productions utilizing fluency enhancing conditions. 

Thirteen adults who stutter were paired with 13 non-stuttering controls. Participants produced 

three-syllable length words across 3 conditions: imitation, pantomime, and production. 

Independent component analysis was utilized to identify mu components. 12/13 PWS and 11/13 

TFS contributed left, right, or bilateral mu components. Activity from both left and right mu 

clusters was localized to the precentral gyri. The procedures described in this study have 

demonstrated effective methods for separating myogenic activity from neural activity during 

complex multisyllabic word production during fluency enhancing conditions.  

 

Key words: stuttering, fluency enhancing conditions, EEG, mu rhythm, independent component 

analysis 
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Identification of the µ rhythm neural components in an EEG time-frequency analysis of speech 

production in fluent speakers and speakers who stutter 

Introduction 

Developmental stuttering is a neural sensorimotor speech disorder that affects the verbal 

fluency of people who stutter (PWS) in the forms of postural fixations, phoneme prolongations, 

and repetitions of syllables, words, and phrases. Although a precise etiology of stuttering is 

currently unknown, converging evidence indicates deficits in sensorimotor control and related 

timing mechanisms (Etchell et al., 2014). Speech is a complex multimodal process involving 

internal modeling of motor commands and desired or actualized sensory feedback in premotor 

and somatosensory neural areas and networks respectively for generating, encoding, comparing, 

and correcting speech motor actions. Ventral premotor areas primarily in the left hemisphere are 

believed to be associated with activations involved with modeling forward speech motor 

commands (Houde & Jordan, 1998; Jones & Munhall, 2005; Purcell & Munhall, 2006). During 

speech, premotor regions generate forward models, or templates, via efference copies that 

contain predictions about sensory consequences for upcoming motor actions (Houde & 

Nagarajan, 2011). Activation of these motor commands engages feedback controllers, or 

correctors, for speech, which then compares the efference copy from the forward model 

transmitted from the anterior premotor regions to the posterior auditory and somatosensory 

regions (Houde & Jordan, 1998; Jones & Munhall, 2005; Purcell & Munhall, 2006). The 

encoded desired or actual sensory consequences from the model are then compared to the speech 

targets and available reafference in sensory regions via parallel internal and external loops 

(Hickok et al., 2011). Predicted sensory information comparisons to the sensory target via 

efference copies are internal loops, while recruitment of external sensory information, 
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reafferance, comprises the external loops (Hickok & Poeppel, 2004, 2007). A sensory feedback 

signal is then sent to the premotor regions to update motor commands and forward models. This 

complex feedforward and feedback system involving premotor regions, posterior auditory, and 

somatosensory regions allows the monitoring of the accuracy of speech output.  

If incongruences between these comparisons occurs it is believed that the auditory or 

somatosensory regions generate an encoded error signal that then sends a corrective motor 

command to the frontal speech motor areas. This process of computing and transmitting forward 

models of desired sensory consequences from premotor to sensory regions and the comparison 

and correction of the motor commands via feedback mechanisms in sensory regions to premotor 

regions is termed inverse modeling (Hickok et al., 2011; Houde & Nagarajan, 2011; Jenson, 

Reilly, Harkrider, Thornton, & Saltuklaroglu, 2018). As described, forward control is more 

dominant in the left hemisphere, while feedback mechanisms are more dominant in the right 

hemisphere. Similar findings occur for limb motor control in functional imaging studies. 

Grafton, Schmitt, Van Horn, and Deidrichsen (2008) found that regions including the dorsal 

premotor cortex, inferior parietal lobule, supplementary motor area and the cingulate motor area 

were correlated with the generation of feed-forward commands while feedback control was 

correlated with bilateral posterior superior parietal lobules and right ventral premotor cortex 

activity.  

 In PWS current hypotheses regarding these deficits are attributed to weak or unstable 

forward models, noisy comparisons between predicted and target sensory consequences, or an 

overreliance on sensory reafferance. Impaired forward modeling may be related to readout of 

forward motor commands or inverse mapping of auditory states onto motor commands (Civier, 

Bullock, Max, & Guenther 2013). Braun and colleagues (1997) discovered that PWS failed to 
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demonstrate typically observed left hemispheric lateralization and noted that regional responses 

were absent, bilateral, or lateralized to the right hemisphere. They suggested that right and left 

hemispheres play distinct and opposing roles in stuttering behaviors and that activation of right 

hemispheric regions could represent compensatory processes associated with the attenuation of 

stuttering behaviors. These findings were corroborated by De Nil, Kroll, Kapur, and Houle 

(2000) who noted greater left hemisphere activation in nonstuttering speakers and proportionally 

greater right hemisphere activation in PWS determining that stuttering adults showed atypical 

lateralization of language processes. Braun and colleagues (1997) also noted that the production 

of stuttered speech showed anterior forebrain regions as disproportionately active in participants 

who stuttered. Fluency evoking, or enhancing, conditions, or speaking conditions found to 

increase fluency in PWS by altering sensorimotor control (Kittilstved et al., 2018), appeared to 

differentially affect activity in various neural regions, including those mentioned above, 

suggesting that such fluency enhancing conditions aided in the facilitation of fluent speech 

production (Braun et al., 1997). Braun and colleagues (1997) noted abnormal hemispheric 

lateralization, absent regional responses lateralized to the right hemisphere, and disproportionate 

activity in anterior forebrain regions in PWS. Beal and colleagues (2015) investigated 

performance during speech-motor tasks in PWS, their findings suggested that the ability to 

establish stable neural motor programs necessary for speech-motor control could be 

compromised. They noted that in PWS, the pars opercularis lacked typical patterns of maturation 

in gray matter thinning across the lifespan in comparison to their control population. In earlier 

research, reductions in left hemisphere grey matter volume in both posterior auditory regions and 

anterior motor areas have been noted in PWS (Beal, Gracco, Lafaille, & De Nil, 2007). 

However, a meta-analysis by Brown, Ingham, Ingham, Laird, and Fox (2005) revealed a 
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hyperactiviation in left pre-motor regions of PWS compared to hypoactivation found by a 

number of other researchers (Braun et al., 1997; Chang, Erickson, Abrose, Hasegawa-Hognon, & 

Ludlow, 2008; De Nil, Kroll, Kapur, & Houle, 2000; Ingham et al., 1996; Watkins, Smith, 

Davis, & Howell, 2008). Interestingly, current research has indicated that PWS demonstrate 

reduced grey matter volume in anterior motor, posterior auditory regions, and left hemispheric 

regions (Beal et al., 2007; Chang et al., 2008; Foundas, Bolich, Corey, Hurley, & Hellman, 2001) 

and reduced white matter density in fiber tracts linking these areas (Chang, 2014; Chang & Zhu, 

2013; Connally, Ward, Howell, & Watkins, 2014; Somme, Koch, Paulus, Weiller, & Buchel, 

2002). While these areas have demonstrated reduced volume, other areas including right 

hemispheric motor regions (Beal, Gracco, Brettschneider, Kroll, & De Nil, 2013) and auditory 

homologues (Beal et al., 2007) have demonstrated increased volume. Furthermore, white matter 

fiber tracts of the right hemisphere in PWS connecting these areas have also demonstrated 

increased density (Beal et al., 2007; Chang, Horwitz, Ostuni, Reynolds, & Ludlow, 2011). 

Deficits in forward control are consistent with speech related hypoactivation in left pre-motor 

regions (Toyomura, Fujii, & Kuiki, 2011) and as such might give rise to an overreliance on 

auditory feedback by increased right hemisphere activation during speech in PWS (Braun et al., 

1997; De Nil, 2000; Fox et al., 2000). Additionally, deficits in forward motor to sensory 

transformations (Von Holst, 1954; Wolpert & Flanagan, 2001) are critical in error detection and 

correction in feedback control of speech (Tourville & Guenther, 2011). Therefore neural imaging 

and theoretical constructs point to the right hemisphere in PWS as overcompensating for deficit 

functions in the left hemisphere in forward and feedback mechanisms. Similar contradictory 

findings have also been revealed in electroencephalogy (EEG) signals. For example, researchers 

have reported weak forward modeling and reduced speech induced auditory suppression in the 
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N100 ERP response (Daliri & Max, 2015), while others have failed to find this difference (Beal 

et al., 2010; Beal et al., 2011). This paradigm does impose the limitation that it is difficult to 

separate internal modeling from neural processes involved with motor execution. Several other 

limitations of this paradigm include: high variability of designs, scanner noise, speech rate, and 

trait versus state differences (fluent or stuttered moments). Due to theses limitations researchers 

have begun to employ different paradigms focused on EEG data.  

 Trait versus state differences in performance of PWS and research designs also likely 

contribute to these inconsistent findings. Trait differences refer to differences between PWS and 

fluent controls in the absence of stuttering behaviors while state differences refer to the 

differences between fluent and disfluent speech of PWS (Jensen et al., 2018). Many 

neuroimaging studies examining stuttering have used a trait-based approach by utilizing well-

known fluency enhancing conditions to induce high levels of fluency in their participants during 

testing. Fluency enhancing conditions endeavor to induce normalization of brain processing 

following the assumption that these conditions are altering the neural processes of PWS in order 

to assimilate what would be represented in a fluent speaker. Some of these common procedures 

are choral speech, shadow speech, delayed auditory feedback, or forms of droned or modified 

speech. When the sensory or motor systems are altered in PWS an increase in fluency is typically 

observed, especially if the introduced signals are speech-like (Kalinowski & Saltuklaroglu, 

2003).  One less well-known, but often used, fluency enhancing condition is that of pantomime 

speech which is silent articulation. Pantomime speech occurs when the speaker who stutters 

mouths an utterance without phonating, it is also known as silent articulatory movement. Similar 

to choral speech this procedure induces nearly 100% fluent productions (Perkins, Rudas, 

Johnson, & Bell, 1976). This is similar to the whispering effect in which fluency is increased to 
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~90-100% when PWS whisper (Perkins et al., 1976). A more commonly known and utilized 

fluency enhancing condition is choral speech, or speaking in approximate unison with a second 

speech signal. Choral speech induces nearly 100% fluency in PWS (Andrews et al., 1982; Cherry 

& Sayers, 1956; Davidow & Ingham, 2013). This effect occurs both when the second speech 

signal is generated by a second human speaker or during the playback of an audio recording. 

Shadow speech, an analog to choral speech, where the speech signals are temporally sequenced 

with lead and lag speech signals, induces nearly 80-90% fluency enhancement in PWS (Hudock 

& Kalinowski, 2014). Furthermore, direct imitation, when the first speech signal is presented and 

the person who stutters repeats the spoken phrase or sentence induces 60-80% fluency 

enhancement (Kalinowski & Saltuklaroglu, 2003). Presentation of these second speech signals in 

whatever form they take likely alters both the sensory and the motor systems of PWS. Alteration 

to the sensory system occurs in a number of ways, the most pronounced is likely the engagement 

of speech production networks. Research suggests that mirror neuron systems are utilized to 

engage these production networks (Kalinowski & Saltuklaroglu, 2003). Human mirror neuron 

systems likely play a role in the imitation, learning, and the understanding of the actions of 

others (Pineda, 2005). Therefore altering the sensory system of PWS likely also has an effect on 

the motor system, specifically the forward models with encoded desired sensory consequences 

for motor commands. By introducing fluency enhancing conditions participants’ trait stuttering is 

positively influenced and neural processing is altered. This is important to note due to the fact 

that neuroimaging studies comparing PWS and typically fluent speakers (TFS) have revealed 

that PWS demonstrate more consistent neural changes during these conditions as compared to 

TFS (Fox et al., 1996; Fox et al., 2000; Toyamura et al., 2011). Research has suggested that a 
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neurological marker of sensorimotor integration and the mirror neuron system is the mu rhythm 

and has recently utilized electroencephalography to investigate these phenomena.  

 Electroencephalography (EEG) with its high temporal resolution, 10 millisecond 

accuracy, and low acoustic, white, noise as compared to functional imaging techniques is prime 

for examining modeling for speech processing in these populations. Machinery utilized in 

functional imaging studies is known to emit white noise, which is a fluency enhancing condition. 

This limitation likely alters neural processing, specifically in PWS during these conditions. In 

hopes of clarifying the utility of EEG designs in this area of study, we present two major 

paradigms commonly utilized in EEG research. A fairly common use of EEG for research is 

event-related designs, which are utilized to examine language processing. Event-related designs 

focus on event-related potential (ERP) responses, which are cortical synchronizations and 

desynchronizations occurring at specific time points post stimulus onset and are typically 

observed after cortical reset. An example of this design is an oddball paradigm where a sentence 

with an incongruent word is presented (e.g., I swung the cat to hit the ball). In this example, 

during observation of the word “cat”, neural language processing areas reset and then activate in 

a characteristic ERP response. Researchers may look at the negative or positive waveform at 

various points across time, most commonly N100 (100ms post stimulus), P200 or P300 (positive 

deflection at approximately 200ms or 300ms respectively), N400, or P600. Each of the 

characteristics’ responses indicates different neural processing. In contrast to this approach, the 

current study utilized a processing design, which investigates activity before, during, and after 

stimulus onset. One method of analysis in this paradigm is through event-related spectral 

potentials, which measure average dynamic changes in amplitude, or power, of the broad band 
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EEG frequency spectrum across time relative to an experimental event (Makeig, 1993), or for the 

purposes of this study, production. 

Using magnetoencephalography in 1989, Tiihonen, Kajola, and Hari demonstrated that 

both alpha and beta frequency band activity can be captured via one dipole location, which may 

offer unique information for speech processing. More recent EEG research has capitalized on 

these findings and studies; however, studies examining the mu rhythm are more frequently found 

in EEG literature, potentially due to costs. The mu rhythm, characterized by peaks in alpha (~10 

Hz) and beta (~20 Hz) frequency bands, represents sensorimotor integration (Pineda, 2005). 

Some of the primary locations for mu rhythm generation are from the pre-motor and primary 

motor cortices (Bowers, Saltuklaroglu, Harkrider, & Cuellar, 2013; Hari, 2006) in anterior dorsal 

stream areas, which are computational hubs for sensorimotor information. Suppression (event-

related desynchronization; ERD) of activity in the beta band is frequently seen during motor 

tasks and is linked to motor execution (Jenson et al., 2014). ERD represents increased neural 

activity or excitation (Makeig, 1993). Mu beta power is modulated before motor production 

(Gehrig, Wibral, Arnold, & Kell, 2012) and following the offset of the action (Kilavik, Zaepffel, 

Brovelli, MacKay, & Riehle, 2013). Further it has been demonstrated that mu suppression is 

independent of muscle force (Kilavik et al., 2013). Mu beta has also shown evidence of 

suppression during action perception and imagination therefore representing possible mirror 

system mechanisms (Brinkman, Stolk, Kijkerman, De Lange, & Toni, 2014). Mu beta encodes 

motor to sensory, forward modeling (Moisello et al., 2015). In opposition, mu alpha suppression 

occurs in response to movement and is considered a primary somatosensory response (Jones, 

2009). Mu beta suppression is linked to motor activity, while mu alpha suppression is 

characteristic of a somatosensory response (Hari, 2006). Mu alpha is also sensitive to changes in 
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visual (Oberman et al., 2005), somatosensory (Hari, 2006), and auditory (Tamura et al., 2012) 

feedback, again indicating mirror system-like responses (Arnstein, Cui, Keysers, Maurits, & 

Gazzola, 2011).  

More recently researchers have used independent components analysis (ICA) of EEG 

signals to perform blind source separations of the oscillatory activity to be temporally referenced 

to muscle movement during time-frequency analysis (Jensen et al., 2014). Oscillatory activity 

from alpha and beta are strongly correlated (Carlqvist, Nikulin, Strömberg, & Brismar, 2005), 

however, researchers have also noted dissociation (Jenson et al., 2014), this indicates the 

presence of distinct yet related sensorimotor functions. Examination of neural activation, ERD, 

and neural inhibition, via event-related synchronization (ERS), through time-frequency analysis 

is particularly useful during studies employing production and movement based tasks. Through 

ICA, noise from muscle movements, or myogenic activity, can effectively be removed from the 

analysis by examining components with minimal muscle noise (e.g., PMC regional generators).  

Utilizing ICA and time-frequency analysis to examine speech production is an effective 

means of separating EMG artifact from neural activity (Jenson et al., 2014; Jenson et al., 2015). 

Changes in oscillatory power across time revealed through ICA and time-frequency analysis 

during speech are interpreted as contributions of forward modeling (mu beta) and sensory 

feedback (mu alpha) (Hari, 2006; Pineda, 2005). Mu alpha and mu beta were seen to emerge 

during speech preparation most robustly in the left hemisphere with the onset of bilabial EMG 

activity and persisting through spoken utterances (Jenson et al., 2018). Interpreted through the 

State Feedback Control (SFC) model (Houde & Nadarajan, 2011) forward models are generated 

in premotor regions and evaluated in posterior sensory regions across the time course of speech 

production with sensory information being sent back to motor regions in the absence of overt 
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errors. Recently a number of investigations have utilized these procedures to examine PWS 

compared to TFS.  

Recent studies have found that PWS demonstrate differential activity across the mu 

rhythm during both speech and tone discrimination in noise (Saltuklaroglu, Harkrider, Thornton, 

Jenson, & Kittilstved, 2017). These results suggest that sensorimotor inflexibility could be rooted 

in reduced forward modeling capacities. Similarly, Joos, De Ridder, Boey, and Vanneste (2014) 

noted that mu beta spectral power was reduced during resting state. This indicates that a possible 

neural biomarker of stuttering may be found in spectral differences. Jenson and colleagues 

(2018) reported that mu beta ERD was reduced in the left hemisphere in PWS implying weak 

forward modeling. Similarly reduced mu alpha ERD demonstrated a reduced ability to process 

sensory feedback in PWS.  

Researchers have measured differences in speech perception (Saltuklaroglu et al., 2017) 

and speech production before in two-syllable and word production conditions (Jenson et al., 

2018), but a paradigm and methodology has not yet been established to observe neural markers 

in congruence with fluency enhancing conditions in PWS during production of complex 

multisyllabic words. It is also important that researchers determine that left and right mu rhythms 

can be identified in such paradigms consistent with pervious studies (Hari, 2006) and provide 

similar spatial and spectral distributions during fluency enhancing conditions. The purpose of 

this methodological-based project is to describe the procedures associated with identifying mu 

rhythm neural components from PWS and TFS during three-syllable word productions utilizing 

fluency enhancing conditions.   
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Methods 

Participants 

Participants were recruited via word of mouth and local network connections. A 

convenience sampling method was used to recruit participants who stutter and then local network 

connections were utilized to find age and gender matched controls willing to participate. 

Participants reported no diagnosed history of cognitive or attentional disorders. Thirteen adults 

who stutter (five females and eight males) with a mean age of 35.2 years of age (range=18-66) 

were age, gender and handedness matched to 13 typically fluent speaking adults (mean=34.8, 

range=19-68). Handedness dominance was assessed using the Edinburgh Handedness Inventory 

(Oldfield, 1971). Handedness information was utilized due to previous research that has 

indicated that handedness can impact lateralization of the mu rhythm (Stancak & Pfurtscheller, 

1996). While this has been mentioned as a concern, it should be noted that other aspects of 

neural components, such as localization, frequency, and amplitude, have not demonstrated 

changes in relation to handedness (Kelly, Mizelle, & Wheaton, 2015). In accordance with Jenson 

and colleagues (2018), both left- and right-handed individuals were included within this study. 

Both males and females were also included within this study in accordance with previous studies 

(Jenson et al., 2018; Kittilstved et al., 2018). The Stuttering Severity Instrument-4th edition, or 

SSI-4 (Riley, 2009) was used to objectively confirm the presence of stuttering and to determine 

stuttering severity for participants who stuttered. All research and informed consent protocols for 

this study were approved by the Institutional Review Board of the Idaho State University Human 

Subjects Committee. Prior to participating in this study, participants provided signed informed 

consent after being verbally briefed about research procedures and participant rights. 
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Stimuli 

Eighty three-syllable length words starting with the consonants /p/ and /b/ and ending 

with stops were chosen from the Psycholinguistic Database to control for linguistic complexity, 

familiarity with language, concreteness, and ability to visualize. Multisyllabic words were 

chosen to allow for increased complexity and use of the chosen fluency enhancing conditions. 

Initial consonants of /p/ and /b/ were chosen to allow for a discrete measure of word initiation 

with EMG bilabial electrode placements and acoustic signatures.  Words ending in stops were 

chosen to allow for a precise offset as determined by EMG and acoustic signatures. Condition 

blocks and stimuli word presentation were randomized in order to control for the adaptation 

effect in stuttering, or the increases noted in fluency when PWS are repeatedly exposed to stimuli 

(Bloodstein & Bernstein-Ratner, 2008). 

The audio files used in the imitation condition were of a male speaker recorded using a 

Macbook Pro in the Audacity program. Each word was recorded three times with the speaker 

sitting two feet away from the recording device. The acoustics of each word production were 

analyzed and the second of three productions or those with the most normalized acoustical 

characteristics were typically chosen. These productions had less temporal and acoustic 

variability. Through Audacity, researchers altered the mean amplitude of the production, 

changed the onset and offset speech envelopes, and ramping amplitude normalization.  

Design 

Stimuli blocks were randomly assigned using a research randomizer. Each block of 

stimuli was preceded by a presentation of welcome instructions. Instructions were followed by a 

one second baseline that was recorded prior to the onset of each orthographic text being shown 

on the participant stimuli monitor. Two of the three conditions (production and pantomime) used 
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the same stimulus presentation sequence while the imitation condition additionally used a 

simultaneous audio presentation of the stimulus word when the orthographic text was presented 

on the screen.  

As depicted in Figure 1, following the baseline time period a one second pre-stimulus 

segment was recorded. The pre-stimulus segment was recorded during the blank baseline 

stimulus slide, no movement was occurring during this segment. The orthographic stimulus was 

then presented for one second; during the imitation condition an audio file of the orthographic 

text was also presented. The orthographic text disappearing from the screen was the cue for the 

participant to initiate production. No participant reported difficulty with the duration of the 

orthographic text and trials with noted artifacts were removed prior to analysis. There was a two 

second long production segment. Following production is two and a half second segment to 

allow for beta rebound, during this time no text was presented. The participants seldom required 

the full time to produce the words. Finally, a standard inter-stimulus interval of one and a half 

seconds was utilized before the next baseline segment occurred (Cacioppo, Tassinary, & 

Berntson, 2007).  

Per EGI recommendation an unreferenced cell list and an unreferenced key list object 

were created to allow researchers to send the trial related specific procedure event codes to 

NetStation Acquisition.  

 

 

Figure	1.	Stimulus	representation	

Baseline/Prestimulus	 Stimulus	Slide	 Production	 Beta	rebound	

2	Seconds	 	 1	Second	 2	Seconds	 2.5	Seconds	
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Procedure 

Participants were recorded during administration of the SSI-4 using Photo Booth with a 

Macintosh iPad for scoring purposes. According to Stancak and Pfurtscheller (1996), handedness 

can influence the proportion of mu rhythm localization, therefore, following administration of 

the SSI-4, participants were administered the Edinburgh Handedness Inventory.   

This study utilized Electrical Geodesics 128-channel EEG HydroCel system with an 

N400 amplifier. EGI NetStation Version 5.3.0.1 was utilized to record each session. According 

to Delorme and Makeig (2004) meaningful results can be obtained with high-density systems 

when independent component analysis is applied. The Physiological Data Acquisition Bipolar 

Physiological Recording System 16 (Physio 16) was utilized to gather EMG data. EMG data was 

integrated into the channels and contributed component information, which resulted in 129 

channels in component analysis. The EGI system was set up in accordance to standard 

procedures, which included a data recording station outside of the participant room. And finally, 

3A E-A-R ear inserts were used to present auditory stimulus in the imitation condition.  

NetStation Tools Version 5.3.0.1 (r23182) was used to export and convert data for 

reviewing and processing purposes. An .mff default file format was converted to a .raw file to 

allow import into EEG Lab for processing. All event markers and timing stamps were intact in 

the exported .raw files. Trained assistants observed EEG recordings and marked overtly stuttered 

trials for deletion following epoching in EEG Lab. Training occurred with research and lab 

assistants on stuttering behaviors by an academic professor, specializing in fluency disorders. 

The EGI system included a data acquisition Macintosh computer running version 10.11.6 

and NetStation Acquisition version 5.3.0.1 (r23182) in addition to the stimulus computer Dell 

OptiPlex 7010 running Windows version 7 Enterprise and E-Prime version 2.0.10.353. A 128-
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channel HydroCel system was utilized in the study in addition to bipolar EMG placements on 

superior and inferior external labial midline. EMG and pulse-oxometery measures along with 

audiovisual recording were integrated through NetStation acquisition software on the Macintosh 

computer used for EEG data collection, therefore resulting in 129 channels for data analysis.  

The experiment was conducted in an electronically and magnetically shielded room (8’ 

4” length, by 7’ 10” width, by 8’ 9” height) with acoustic insulation at 60 dB reduction capacity 

and electromagnetic shielding insulation with a solid acoustic dampening door. Participants 

could be viewed through a window outside of the data collection room where the stimulus and 

data collection computers were housed.  

In accordance with EGI and FDA standards for the EGI system, all powered electronics 

were routed through hospital grade transformers to reduce electrical noise and the potential of 

electrocution.  

Stimuli were presented via monitor (20”x11 ¾”) placed approximately two feet directly 

in front of participants. Earphones were inserted. An HD 1080p Logitech camera was utilized 

within the data collection room for later analysis of overtly stuttered trials. A cushioned chair 

with arms was placed approximately 24 inches in front of the monitor. LED lights with variable 

resistors were used to decrease magnetic noise in both the data collection room and the data 

analysis area.  

In the data acquisition and stimuli computers the RAM was upgraded to 16.0 GB with 

four memory slots and 32.0 GB, respectively. The data acquisition computer used a 3.7 GHz 

quad core Intel processor and the stimuli computer used an Intel® Core™ i5-3470 processor at 

3.2- GHz. Data processing was completed utilizing a Dell computer with Windows version 7 

Enterprise. Data processing was completed using EEG Lab 13.6.5 and MatLab version 13_6_5b. 
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The data processing computer used an Intel® Core ™ i7-6700K CPU at 4.00 GHz had a 

7.1.12.0.0.7723 graphics card and 32 GB of RAM.  

EEG Acquisition 

The circumference of the participants’ heads was measured to determine the size of the 

EEG net and a midpoint was determined on their scalps for net placement. The EEG net was then 

soaked in an electrolyte solution (potassium chloride and Johnson’s baby shampoo) for a 

minimum of five minutes to saturate the sponges with electrolyte. A trained lab assistant then 

placed the net and adjusted the electrodes to sit on the scalp, below the participants’ hair. 

Participants were then led into the data collection room. 

Participants were seated in the collection chair and the net was connected to a pre-

amplifier (number# 1.6.17). EGI NetStation Acquisition was started and impedances were 

recorded. Based on the impedences, electrodes were adjusted in order to have all impedances 

below 100 kHz. EMG electrodes were placed on the participants’ lips and ear inserts were placed 

for auditory condition blocks.  

Using E-Prime, six trial blocks were presented to the participants, each block lasting six 

minutes and fourteen seconds. Between presentation blocks, a lab assistant entered the collection 

room, checked on the participant, adjusted the net, and rerecorded the impedances. Participants 

were given instructions about the next trial block at this time.  

Following data collection, EGI instructions on net care were followed.  

Processing 

Behavioral analysis. 

Files obtained from data collection were run through an epoching tool via NetStation 

Tools to segment the video into numbered trials. Audio-visual analysis was then completed 
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utilizing NetStation Review. Trained lab assistants analyzed audio-visual recordings of the 

participants and manually recorded stuttered trials, distracted trials, and trials where the 

participants were not alert, for removal during preprocessing. EMG and acoustic signals were 

analyzed in conjunction with audio-visual recordings for confirmation of atypical productions. 

Each trial identified was recorded in the lab book by trial number and condition block for later 

removal. 

 Data preprocessing. 

Following audio-visual analysis, the .mff file produced by NetStation Acquisition was 

converted to a .raw file using NetStation Tools in order to transfer and preprocess the files on the 

data processing computer. Files were transferred onto an encrypted hard drive and then loaded 

onto the processing computer.  

The .raw files were then uploaded into MatLab and trial blocks (i.e. Imitation 1, Imitation 

2) were appended to form three data sets (i.e. Imitation, Pantomime, and Production). Channel 

locations were then edited to fit the Brain Electrical Source Analysis (BESA) spherical model in 

the DIPFIT toolbox (Oostenveld & Oostendorp, 2002) and the EMG channel was appended to 

the data set as the 129th channel. Following channel location editing, the sampling rate was 

adjusted to 256 in order to ease the computational load. The data was then filtered using a basic 

FIR filter with 3 Hz at the lower edge of the frequency pass band and 34 Hz at the higher edge of 

the frequency pass band. Data was then re-filtered with the same parameters. Following the 

filtering process, data was then re-referenced to compute average reference.  

Files were then resaved before epochs were extracted, meaning that specific time-

windows were extracted from the continuous EEG signal. When extracting the data epochs, 

PROD (production) was selected as the time-locking event type with epoch limits set at -3 
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seconds and 4.1 seconds. One second of pre-stimulus was included; the remaining pre-stimulus 

time was used for group level analysis whereas the relative baseline (-2 to -1) was used in 

individual analysis.  

For the first five participants, for student training purposes and procedural understanding, 

the graphic user interface was used to go through the steps of preprocessing. Once the lab 

assistants and researchers were familiar with the processes, scripts were created from point and 

click options and were then utilized to reprocess the data from the original files.  

According to Delorme and Makeig (2004) when data contains more strong spatial sources 

than recording channels, the sources are mixed into output components. When paroxysmal noise 

is introduced into EEG data during strong head movements or a loose electrode is present, large 

noise signals not related to other electrode signals may occur. Therefore, in order to perform ICA 

to separate neural and artifact sources, data must be carefully cleaned (Delorme & Makeig, 

2004). Lab assistants were trained to identify noisy and inaccurate trials within the data during 

the cleaning process. Epochs were scrolled through from baseline to baseline as researchers 

searched for blinks or synchronizations across frontal electrodes. These trials were selected and 

rejected. At this point, trials that had been previously recorded during behavioral analysis were 

selected and rejected as well.  In order to be considered for later ICA and group level analysis, 

condition blocks were required to retain at least 80% of trials in accordance with lab training 

procedures. Delorme and Makeig (2004) also noted that a small set of data averages might not 

include enough conditions in the set to demonstrate independence of the neural processes. Files 

were resaved following this process.  
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 Independent component analysis. 

Following cleaning, all conditions for a singular participant were loaded into EEGLab 

and selected. ICA was then completed to detect stereotyped eye, muscle, and line noise artifacts 

(Delorme & Makeig, 2004). This also developed a coordinate frame for the data projections to 

have minimal temporal overlap (Delorme & Makeig, 2004). Datasets were concatenated in order 

to keep the conditions separate but utilize data from all six blocks. Concatenating the data 

produces more accurate decompositions and clustering of dipoles for later analysis.  

 Group study/analysis. 

Following the processing steps, a group study was created within EEGLab. While loading 

participants’ files into the study, participants were grouped (PWS=group 1; Controls=group 2) 

and studies were labeled by condition (imitation=1; pantomime=2; production=3). Once all 

participant data was loaded, component measures were precomputed (‘alpha’,[.05],’baseline’,[-

3000 -1000] event-related spectral perturbation, or ERSP setting). At this level, principal 

component analysis (PCA) was also completed. PCA is applied temporally and makes successive 

components account for as much of the activity as possible without correlation to previously 

determined components (Delorme & Makeig, 2004) as opposed to ICA. 

Once the group study processing was completed, a preclustering array was built. The 

preclustered data was then clustered into 129 clusters using a Kmeans alogrithm. This allowed 

researchers to check spectra, dipoles, scalp maps, and ERSPs with similar activity. Each cluster 

represented a similar group of dipoles, location, spectra, and ERSPs.  

Components within each cluster were manually analyzed by a trained lab assistant and 

sorted into four categories: Left Mu, Right Mu, Left Mu Rejects, and Right Mu Rejects. 

Categorization was determined based on a series of criteria. The first criterion was spectral 
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analysis. Components observed to have amplitude peaks at approximately 8-13 Hz and 17-30 Hz 

were considered for further inclusion, which correspond to alpha and beta bands respectively 

(Jenson et al., 2014). Following spectral analysis, the dipole location of each component was 

considered. Components with greater than 30% residual variance (RV) were rejected during 

individual analysis with the caveat that the overall cluster remained below 20% (D. Thornton, 

personal communication, August 13, 2018).  Residual variance is the mismatch between the 

forward projections and the original scalp recorded signal (Saltuklaroglu et al., 2017). 

Component coordinates were entered into Talairach Database and the approximate location was 

determined.  To be included in further analysis, the dipole location was required to be within 

Broadman’s areas 1, 2, 3, 4, and 6 (somatosensory regions, primary motor and premotor regions) 

(Jenson et al., 2014). Final component designations were based primarily on the PCA followed 

by inspection of scalp maps, spectra, dipoles, and ERSP data. ERSP analyses were utilized to 

compute changes in power across time.  

Results 

 Due to the methodological descriptive nature of this project, the results are shown below 

in Table 1 and 2, representing individual contributors of mu rhythm neural components.  

Participant 
# 

Sex Age Handedness Mu 
Contributions 

Left Right 

5 M 33 R L, R 1 1 
8 F 26 R L, R 3 3 
10 F 21 R L, R 1 1 
11 F 24 R L, R 3 4 
12 F 25 L L, R 3 2 
14 M 45 R L, R 1 1 
15 F 24 R L, R 1 2 
18 M 48 L R  3 
25 M 65 R R  1 
27 M 66 R L, R 1 1 
28 M 38 R L, R 1 3 
38 M 24 R L, R  3 3 
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Table 1. Demographics and cluster contributions for PWS submitted to neural analysis. The 
presence of mu components in each hemisphere and number of components included in analysis 
are indicated.  
 
Participant 
# 

Sex Age Handedness Mu 
Contributions 

Left Right  

9 M  32 R L, R 2 1 
21 F 24 R R  2 
16 F 24 R L, R 3 4 
32 F 26 L L, R 4 4 
30 M 46 R L, R 1 1 
37 F 22 R L 1  
19 M 44 L L, R 2 2 
23 M 68 R L, R  1 2 
31 M 39 R L, R 1 3 
45 M 23 R R  1 
17 M 19 R R  2 
Table 2. Demographics and cluster contributions for TFS submitted to neural analysis. The 
presence of mu components in each hemisphere and number of components included in analysis 
are indicated.  
 
Mu Cluster Characteristics  
 

Figures 2 and 3 show the distribution of components contributing to left and right mu clusters 

for both the PWS and matched controls. Of the 13 PWS whose data were included in the ICA 

analysis and group study, 12 (92.3%) produced either left or right mu components. Ten produced 

bilateral mu components and 2 produced only right mu components. For the matched controls, 

11 (84.6%) produced either left or right mu components. 7 produced bilateral mu components, 1 

produced only left mu components, and 3 produced only right mu components.  

Left Mu 

Data from 13 matched pairs were included in the left mu cluster. The total number of 

contributions to the left mu cluster by PWS was 18 while 15 components were contributed by 

their matched controls. The average location for the left mu cluster was at [-30, -17, 47] (BA 4) 

as determined by Talairach. This placed the activity primarily in the left cerebrum precentral 

gyrus. There was an average unexplained RV of 10.35% (standard error=1.1143). 
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Right Mu 

 Data from 13 matched pairs were included in the right mu cluster. The total number of 

contributions to the right mu cluster by PWS was 25 while 22 components were contributed by 

their matched controls. The average location for the right mu cluster was at [29, -15, 47] (BA 4) 

as determined by Talairach. This placed the activity primarily in the right cerebrum precentral 

gyrus. There was an average unexplained RV of 10.05% (standard error=0.9196). 

 

Figure 2. Results for left mu cluster. Mean spectra (top) for cluster components (PWS are blue, 
PWNS are green). Dipole locations (bottom left) for components contribution to mu cluster 
(PWS are white, PWNS are blue, average is red) illustrating cluster localization. Topographical 
scalp map (bottom right) representing the distribution of cortical activity.  
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Figure 3. Results for right mu cluster. Mean spectra (top) for cluster components (PWS are blue, 
PWNS are green). Dipole locations (bottom left) for components contribution to mu cluster 
(PWS are white, PWNS are blue, average is red) illustrating cluster localization. Topographical 
scalp map (bottom right) representing the distribution of cortical activity. 
 

Discussion 

The procedures described in this study have demonstrated effective methods for 

separating myogenic activity from neural activity during complex multisyllabic word production 

in PWS during fluency enhancing conditions. Data collected and processed in this study revealed 

similar outcomes to those found in non-production based tasks in PWS utilizing high-density 

EEG systems (Bowers et al., 2013; Jenson et al., 2014). Band-pass filtering, cleaning, and ICA 

effectively allowed acquired EEG data to be analyzed with minimal myogenic activity 

interference. 

Once processed and clustered, the resulting useable data in this study was similar to past 

studies with contribution proportions of 92.3% in the control population and 84.6% in the PWS, 

similar to previous studies. Kittilstved and colleagues (2018) reported 79% of their participants 
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contributed useable components. Similarly, Bowers and colleagues (2013) found that 84% of 

their participants contributed left or right sensorimotor mu components. In Jenson and 

colleagues’ (2014) study, they reported that 80% of their participants contributed components. 

Identified mu rhythm component localization in the primary motor cortices, primary 

somatosensory cortices, and the premotor cortex are consistent with previous findings (Hari, 

2006; Pineda, 2005) and expected anterior dorsal stream activity, indicative of sensorimotor 

integration (Hickok et al., 2011; Houde & Nagarajan, 2011). It is important to look at and 

identify mu rhythm components in these areas based on the previous research. Through a 

weighted identification system for the mu rhythm, utilizing topographical scalp map information, 

followed by spectral analysis, and dipole localization confirmation via Talairach, we are able to 

determine the presence of mu rhythms in sensorimotor integration areas, supporting prior 

methods used during speech perception and syllable production tasks (Bowers et al., 2013; Hari, 

2006; Houde & Nagarahan, 2011; Jenson et al., 2014; Kittilstved et al., 2018; Pineda, 2005). 

The current study demonstrates a general guideline for processing and analyzing EEG 

data and provides evidence validating its use. However, we recognize that, adjustments to these 

protocols would be necessary increase the reliability. Firstly, more efficient participant matching 

should be completed. Participants should be matched following ICA of participants who stutter 

in order to insure that only the PWS who are contributing components are matched with a control 

(Jenson et al., 2018; Kittilstved et al., 2018). Following this step, the proposed controls should 

also be screened to insure that all contributing PWS are matched with a contributing control. 

Secondly, the subjectivity of data processing and analysis should be addressed. Hand picking and 

sorting methods utilized in past research have been sound, however, there are now automated 

processing options. Implementation of programs, such as the multiple artifact rejection algorithm 
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(MARA), can reduce the amount of subjectivity in selecting clusters and components throughout 

the analysis process. Also, it should be mentioned that both left- and right-handed individuals of 

both genders were included in this study, adhering to previously published evidence in this area 

(Jenson et al., 2018; Kittilstved et al., 2018). Previous research has suggested that participants’ 

handedness can affect localization of the mu rhythm (Stancak & Pfurtscheller, 1996), however, 

handedness does not appear to affect other aspects of the mu rhythm. Kelly, Mizelle, and 

Wheaton (2015) reported similar findings in the differences between lateralization of cortical 

activity in left- and right-handed individuals in a study focused on action outcomes. While their 

study was focused on limb action, they suggested that the cortical networks involved in the 

understanding of action outcomes might be dependent on handedness and cortical dominance. 

We acknowledge that there has been a historical concern with both gender and handedness 

differences in neuroimaging research. However, upon further investigation, the literature in this 

area is primarily based on task dependent issues or neurochemical differences and limited 

research is available in the area of speech perception and production paradigms. And finally, lab-

to-lab variability in protocols should be addressed. Steps in processing and certain requirements 

vary greatly between EEG labs reducing the ability to replicate studies. Some of these 

differences include, but are not limited to: RV requirements and cleaning retention rates. 

Utilization of EEG between manufacturers and labs varies greatly. Likewise, so do the 

recommended methodological procedures for cleaning, processing, and analyzing the EEG data, 

which prompted this methods-based project to result in a more standardized presentation of 

procedures used with EEG in speech production tasks during a time-frequency analysis and 

processing style designed experiment.  
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Conclusions 

 ICA was successfully utilized to separate muscle artifact and neural activity in EEG data 

collected during speech production tasks. This allowed the identification of sensorimotor mu 

components within the data. The current methods, with limitations addressed, are an effective 

means to collecting and processing EEG data in complex multisyllabic word production based 

tasks and fluency enhancing conditions with minimal myogenic activity interference in PWS and 

control populations.  

Limitations 

While the current study provided a reliable way to collect data, some limitations should 

be addressed. First, a common limitation across EEG research is the subjectivity of data 

processing and analysis. Some of the subjectivity in analysis can be mitigated through programs 

such as MARA, which is an automatic classification system of artifactual ICA-components for 

artifact removal. Another area of subjectivity in this field is lab-to-lab variance in protocols, such 

as: RV requirements, cleaning retention rates, and the inclusion of both left- and right-handed 

individuals and both genders.  Second, the participant matching protocol was not the most 

effective method. In this study, non-contributing controls were not replaced to match the 

participants who stutter that contributed. Due to this limitation, two participants who stutter did 

not have contributing controls and one control was included with a non-contributing PWS. Also, 

it must be acknowledged that due to research noting that handedness can affect the distribution 

of neural components (Stancak & Pfurscheller, 1996) a study separating left- and right-handed 

individuals in studies may be a prudent direction. And finally, while condition blocks were 

randomized per participant, when the condition blocks were split, one trial block had primarily 

/b/ words and the other had primarily /p/ words.  
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Future Directions 

 Future studies should utilize the provided procedures, after limitations are addressed, to 

test model predictions in future studies by investigating group differences and connectivity 

measures across sensorimotor integration areas. These methods can also be used in other 

perception-production paradigms, such as phonological working memory tasks. The information 

and understanding that could be gained from these studies could lead to an earlier identification 

of persistence versus natural recovery in children who stutter. It could also lead to quantifiable 

measures of therapeutic gains within stuttering therapy. Speech network differences during 

fluency enhancing conditions in PWS should also be investigated as this data may pave the way 

for the use of neurofeedback in targeted therapeutic techniques.  
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Appendix A 

Left and Right Mu Cluster ERSP Images 
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Appendix B 

Single Participant Spectral Comparison 

 

 Participant 11 (PWS) demonstrated abnormal mu components with uncharacteristically 

high amplitude beta peaks at a slightly higher frequency. In this image Participant 11’s spectrum 
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(top) can be seen in comparison with a mu component typically seen in a PWS (middle) and a 

typically fluent speaker’s mu component (bottom). On average the PWS contributed 1.8 

components in the left hemisphere and 2.1 components in the right hemisphere. This individual 

contributed 3 components in the left hemisphere and 4 components in the right hemisphere, a 

higher proportion than the average, which might influence results.  
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Appendix C 

Lab Tutorial: Preprocessing Through Dipole Pairing 

Step by Step Guide to EEGLAB  
Run files through “epoching” tool in Net Station Tools on Mac 
Net Station Tools  
Hit +, import the file you want to watch. 
Run through epoching tool.  
Open arrow to Net Station Review and watch through and write stuttered trials in lab book 
Write down any bad channels during collection 
 
Open MatLab R2014b→in drop down area select C:/Users/Dan/Desktop/eeglab13_6_5b 
Type eeglab→ Enter 
File→ Import data → From File IO Interface 

 
Select data →Name data PT#_Imm, Prod, or Pant1 
Repeat with Imm, Prod, or Pant2 
Select the first data set 
Edit→ Append data  
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• Append 1 and 2 data sets 
• Edit Channel locations 

• Edit-> Edit channel locations 
 

o Use BESA head model 
o → Read locations in bottom left shown below 
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o Upload “GSN-129.sfp” File 
o Scroll to end, Append channel, type EMG in label 

 

 
 

o Uncheck “channel in data array” boxes for any bad channels 
o Click okay; front screen should look like this. 
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o Change sampling rate 

• Tools – Change Sampling Rate: 
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• Enter 256 in the window in order to ease computational load. 

 
o Hit OK, a new window will pop up after some processing, hit OK on this window as 

well. Now you can confirm that you have changed the sampling rate here:  
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o Filter 

• Tools->Filter the data -> Basic FIR filter 

 
o Filter at whatever your desired settings, in our case, 3 to 34 TWICE. 
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o Hit Ok. More processing will occur, and if you check the bottom box, a frequency 

response plot will appear – you can close this. Once again, a rename dataset box will 
appear, just hit OK as well. 
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Re-reference 

 
c. Check the box that says “compute average reference” and click Okay.  

 

 
Hit Ok. Again, a rename dataset box will appear, just hit OK as well. Your EEGLAB window 

will confirm this step, shown here: 
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Save as at this stage as: 
Pt#_Pant, Imm, or Prod_Prepro 
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• Extract epochs 
• Tools->Extract Epochs 

  
• The […] button opens up the time-locking events. We want to select PROD. Epoch 

limits, also circled, is another important change. You have to change these numbers 
relative to your time “0” which is the onset of stim+. In our case, we run at -3 to 4.1. 
Updates seen here: 

 



METHODOLOGICAL APPROACH TO IDENTIFICATION OF THE MU RHYTHM IN 
SPEECH 
	

   48 

 
• Hit Ok, and you see another rename window, just hit ok again. That pops up the 

remove baseline window, go to step b. 
• Remove baseline 
• Show below, this allows you to pick a baseline – all signs point to this not mattering 

at all for later processing. Just enter your whole epoch in MILLISECONDS. For us, -
3000 4098. 

 

 
 

• Hit Ok, and you see another rename window, just hit ok again 
• Now, you should see your epoch number update on the EEGLAB window, so it looks 

like this: 
 
Cleaning 
Reject noisy/inaccurate trials 

o Now it is time to look at the data, see how noisy it is, and reject noisy or 
inaccurate trials.  

o Plot -> Channel data (scroll) 
o Scroll through epochs (BASE to BASE) for blinks, synchronization across frontal 

electrodes. Don’t reject more than 20% or consider throwing out data set; All of 
our conditions have 80 trials, need at least 60 to run ICA. 
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o View the Data 
o The above menu will pop up this window (shown below). Type in 80 in the box at 

the bottom (also shown in image). 
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In green, we find a great trial, nice and clean. In red, we see some great examples of bad trials. 
Clicking back trials will highlight them in yellow. Hit the right and left arrows to navigate 
through the trials to select all that should be rejected. Then hit reject. It’ll ask “Are you sure?” 
Make sure you are, because you have to start over if you reject trials you don’t want to actually 
get rid of. Hit Yes, another rename pop up, hit okay. 
 
Congratulations! You have a file that has been cleaned. Next, save this file: 
File->Save current dataset as-> Pt#_Imm, Pant, or Prod_Cleaned 
 
Repeat with all three conditions, then load files and run ICA together (use .set files not .fdt files). 
Make sure all data files are selected: 

 
 
ICA 
Tools->Run ICA 



METHODOLOGICAL APPROACH TO IDENTIFICATION OF THE MU RHYTHM IN 
SPEECH 
	

   51 
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Set this window just like it is shown (above), be sure to check “Concatenate all datasets (check=yes; 
uncheck=run ICA on each dataset)?. 

During this process, your Matlab window will do things like this: 

          
Be patient, the whole process can take a long time. 
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o Once this has run, and it’ll look something like THIS (below) when it has finished, you can look 
at scalp maps under (Plot->component maps->in 2-D). This will let you see if you have gotten a 
decent decomposition.  

o Save as Pt#_Imm,Prod, or Pant_ICA 
o EEGLab may show that there are no ICA weights, if so, clear all data sets, reload the “clean” 

files, check for ICA weights and then save those files  
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o Select one dataset 
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You can look at scalp maps under (Plot->component maps->in 2-D). This will let you see if you have 

gotten a decent decomposition. Hit OK on the first menu pop up. 
 

Scalp maps are shown here: 

 
From here, you have your ICA decomposition. The next step is getting dipole information. 
Though my recommendation would be to save EACH dataset so you have the intermediary step 
to go back to if needed. 
 
Save pictures as PT#_Imm, Pant, orProd_ScalpMap.jpg 
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Plotting Component Properties: 
1. Investigate number that could indicate possible Mu. 
2. Set from 4 30 Hz in brackets 

 
Plot time frequency transformations:  
Event-related synchronization, desynchronization.  
 
Component time frequency.   
 
DIPOLE: 
Load ICA files into EEGLab 14. 
Tools→ Locate dipoles using DIPFIT2→ Head model and settings 
BESA Head Model 
Manual Co-reg, warp montage 
Pair channels- E 9→6, 11 → 24, 22→4, 24→21, 33→19, 36→43, 45→T7, 52→P3, 58→P7, 
62→Pz, 70→O1, 75→Oz, 83→O2, 92→P4, 96→P8, 104→C4, 108→T8, 122→F8, 124→F4. 
Tools→ Locate dipoles→ Autofit 
Plot resulting dipoles (check) box 
Locate dipoles using DIPFIT2→ Plot component dipoles 
Save data as→ Pt#_imm,prod, or pant_dipoles.set 
 
YOU ARE DONE (for now) 
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Appendix D 

Lab Tutorial: Group Study 

Group Study 

• Open EEGLab 14. 
• File→Create study→ Browse for data sets. 
• Load in studies labeled by condition. All sessions are 1.  
• People who stutter are group 1, controls are 2.  

 

Once all are loaded, 

• Precompute component measures → Select ERSPs then enter: ,’alpha’,[.05],’baseline’,[-
3000 -1000] next to ERSPs (add to the last box after the preexisting contents) 
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• Build preclustering array once the study is finished running. 
o Check spectra (Power Spectrum), dipoles, and scalp maps. If error messages are 

coming up, try only checking dipole box.  
• Cluster components, don’t change algorithm. # of clusters corresponds with number of 

channels. Dave says 35-45. 
o Clusters represent similar groups of dipoles, location, spectra, and scalp.  
o Reassign component and move it over to the right cluster. 

Cluster for right and left mus. Will look something like this. 
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Mu-like components in inf. Parietal lobe, inferior frontal gyrus, don’t look at them.   

 
When looking at spectra of components, select “Params” and adjust settings:  

• Top box→ 5 27 
• Leave second box blank 
• Check subtract individual mean spectrum 
• Check plot first variable on the same panel 
• Leave detach plots selected  

 


